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Overview of the NS/Router Configurator

NetSoft's NS/Router Configurator is a configuration utility that allows you to create a variety
of AS/400 system connectivity configurations.
This program is windows-based, menu-driven and allows you to:

 Create router configuration files.
 Edit existing configuration file.
 Change PC to AS/400 Link Information
 Add AS/400 System Information
 Change AS/400 System Information.
 Delete AS/400 System Information.
 Set Start Up Preferences.



A Quick Look at NS/Router Configurator

The NS/Router Configurator window is shown in the following diagram.

Select an area on the diagram by clicking on it with your mouse. Information about that 
topic will be displayed. (You can also select an area using Tab and Enter on the keyboard).



PC to AS/400 Connection Information Area

The PC to AS/400 Connection Information group box is used to select and define the link 
type you are using between the PC and AS/400.



PC to AS/400 Connection Information

The PC to AS/400 Connection Information group box is used to select the link type you are 
using between the PC and AS/400. This version of NS/Router only supports NetWare for 
SAA.

The current (or default) link information for the specified link is then displayed in the Link 
Information box.

Click on the Change... button to change the current link information or to specify more 
advanced parameters.



PC Information Area

The PC Information group box allows you to enter the Network Identification (NetID), PC 
Location Name and the Common User ID.



PC Information

The PC Information group box allows you to enter:

    Network Identification (NetID)
    PC Location Name
    Common User ID



Network Identification ID

The NetID (defined on your AS/400) should be no more than eight characters with no 
spaces allowed. When entered, the entry is automatically converted to uppercase. The 
default is APPN.



Common User ID

The Common User ID field is used to specify the user ID to be included in ALLOCATE 
conversation request to AS/400s. The Common User ID is an optional field that, if used, 
must be 1 to 10 alphanumeric characters with no spaces allowed. When the router is 
started it will first attempt to use the User ID specified in the AS/400 System Information 
group box. If the User ID is not specified, it will then attempt to use the Common User ID 
specified in the PC Information group box. If this Common User ID is also not specified, the 
router will prompt you for an ID when you open the router configuration file (*.RTR).



Location Name

The PC Location Name can be any eight characters but the first character must be a letter 
and no spaces are allowed. This name will be used in the autoconfiguration process of the 
AS/400 to create controller and device descriptions that describe your PC to the AS/400. 



AS/400 System Information Area

The AS/400 System Information group box requires that you identify each AS/400 system 
that you wish to access.



AS/400 System Information

The AS/400 System Information group box allows you to:

    add a new AS/400 system
    change information for an existing AS/400 system
    delete an existing AS/400 system

To add a new system, click on the Add... button. The Add System Information dialog box is 
displayed.

To change an existing system, highlight the system in the group box and click on the 
Change... button. The Change System Information dialog box is displayed.

To delete a particular AS/400 system entry in the list, highlight the system in the group box 
and click on the Delete... button. A message box displays asking if you want to delete the 
selected system. Select Yes to confirm the deletion or No to cancel the deletion.

If you are using the NetWare for SAA Link, when you delete an AS/400 system all other 
AS/400 systems connected via that system are also deleted.



Required software versions

The NS/Router Configurator requires the following software versions:

    Windows 3.1 or later
    Adapter interface software appropriate to your communications adapter
    NetWare for SAA version 1.3B running at your NetWare server. 



Fine print
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File Menu Options

The File menu offers the following commands:

New Begins a new router configuration file.
Open Opens an existing router configuration file (default 

extension .RTR).
Import Opens an existing PCS file (default extension .PCS) and 

imports the configuration information into the NS/Router 
configurator.

Save Saves the current (open) router configuration file using the 
same filename (default extension .RTR).

Save As Saves the current (open) router configuration file to a 
specified file name (default extension .RTR).

Exit Exits NS/Router Configurator.

New command (File menu)

Use this command to create a new untitled router configuration file in the NS/Router 
Configurator window. 

Choosing this command removes the active router configuration file from the NS/Router 
Configurator window.    If you have made changes to the router configuration file that you 
have not yet saved, you will be prompted to save those changes before the router 
configuration file is removed.    You can now create a new router configuration file.

You can open an existing router configuration file (default extension .RTR) with the Open 
command.



Open command (File menu)

Use this command to open an existing router configuration file (default extension .RTR).

Choosing this command displays the File Open dialog box which allows you to specify the 
name and location of the file you wish to open.

You can create a new untitled router configuration file with the New command.



Import command (File menu)

Use this command to import configuration information from an existing PC Support 
configuration file (default extension .PCS) into an NS/Router configuration file (default name
CONFIG.RTR). The original PC Support configuration file is left intact.

Choosing this command displays the File Open dialog box which allows you to specify the 
name and location of the file whose information you wish to import.

Related Topics
Import Information from an Existing PC Support Configuration File



Save command (File menu)

Use this command to save the active router configuration file to its current name and 
location. No further dialog boxes are displayed.

When you save a router configuration file for the first time (e.g., an untitled router 
configuration file), the Save As dialog box is displayed so that you can name your router 
configuration file.

If you want to change the name, location or extension of an existing router configuration 
file before you save it, choose the File: Save As command.



Save As command (File menu)

Use this command to save and name the active router configuration file with a new or 
different name.

Choosing this command displays the Save As dialog box which allows you to specify a new 
or different name and location.

If you want to save a router configuration file with its existing name and location, use the 
File: Save command.



Exit command (File menu)

Use this command to end NS/Router Configurator.

NS/Router Configurator prompts you to save your configuration file.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Contents Offers you an index to topics on which you can get help.
Search for Help on Allows you to search for a help topic by typing a word in a 

text box or selecting a word from a list box.
How to Use Help Provides general instructions on using help.
About... Displays the version number and other information for the 

NS/Router Configurator.



Help Contents command (Help menu)

Use this command to display the opening screen of Help.

From the opening screen you can access step-by-step instructions for using NS/Router 
Configurator and various types of reference information by clicking on any underlined word 
or topic. For example, the Quick Look... topic accesses an overview of the main NS/Router 
Configurator screen.

Once you are within the Help system you can click on:

    any underlined word or topic for reference information pertaining to that word or topic.
    the Contents button whenever you want to return to the opening screen.
    the Search button to access Help's index facility.
    the    Back button to return to the previous topic.

If you are a novice at using Window's help, use the Help: Using Help menu option for 
detailed instructions on using Help.



Search for Help On Command (Help menu)

Use this command to display the Search dialog box where you can type a word in the text 
box or select a word from the list box. 
After you have selected the word, click on Show Topics and all of the topics related to the 
word are displayed. 
Highlight the topic you are interested in and click on the Go To button to display help 
information on that topic.



How to Use Help command (Help menu)

Use this command for detailed instructions on using Help.



About command (Help menu)

Use this command to display the copyright notice, version number and other information 
about your copy of the NS/Router Configurator.



Minimize button

Use this button to reduce the NS/Router Configurator window to an icon.



Maximize button

Use this button to enlarge the NS/Router Configurator window to fill the available space.



Close command (System menu)

Use this command to close the active window or dialog box.

Double-clicking on the Control-menu box is the same as choosing the Close command.

Shortcut
Keys: ALT+F4 closes the NS/Router Configurator window or dialog box



Title Bar

The title bar shows the name of the current open NS/Router configuration file (*.RTR). If 
there is no currently open file, the title bar reflects Untitled.



Menu Bar

The menu bar groups commands into categories. 



The Menu Bar

The Menu Bar groups commands into categories:

    File Menu
    Help Menu



Main Configuration Window

The NS/Router Configurator window is shown in the following diagram.

Select an area on the diagram by clicking on it with your mouse. Information about that 
topic will be displayed. (You can also select an area using Tab and Enter on the keyboard).



Importing Information from an Existing PC Support Configuration 
File

The Import option serves as a DOS migration service, allowing you to take configuration 
information from an existing PC Support Configuration file and place it into an NS/Router 
configuration file in Windows. The original PC Support Configuration file is left untouched. 
To perform an import, perform the following steps:

1. Click on the NS/Router Configurator icon to start the configurator.
2. From the File Menu select the Import... option. The Import dialog box is displayed.
3. Select the location and name of the PC Support Configuration file (default .PCS) that you 

want to import and then choose OK.
4. The configuration information from the PC Support Configuration file will be imported 

into the NS/Router Configurator and the default name of CONFIG.RTR will be used.
5. From the File Menu select the Save As... option and save the new file; you may rename 

the file if you wish. The original PC Support Configuration file is left untouched.



Change NetWare for SAA information



Change NetWare for SAA Link Information

The Change NetWare for SAA Server Information dialog box, shown in the following 
diagram, allows you to select several options related to the NetWare for SAA physical link.

Select an area on the diagram by clicking on it with your mouse. Information about that 
topic will be displayed. (You can also select an area using Tab and Enter on the keyboard).



Transport Protocol

The Transport Protocol drop-down list box indicates the connection type the NS/Router will 
be using. You may select either IPX/SPX or TCP/IP via TLI. 

If you are using the TCP/IP transport protocol TCP/IP, you must have Novell LAN Workplace 
for DOS (LWP) version 4.01 or later loaded.

If you are using the the Novell NetWare IPX/SPX LAN transport protocol, you must have 
Novell's IPX drivers loaded. The link driver supports any LAN adapter supported by 
NetWare's IPX. The NetWare client shell (NETX) does not need to be loaded, unless you also
require access to NetWare file services (such as a file server).

Transmission Control Protocol/Internet Protocol (TCP/IP) is a suite of protocols for process-to-
process communications across an internet. This version of NS/Router supports the TCP/IP 
interface via Novell's TLI standard. Novell's LAN Workplace for DOS provides the necessary 
Windows drivers that meet the TLI specifications that NS/Router's TCP/IP link driver expects.
See your LAN Workplace for DOS documentation for further details.



Server Name

The NetWare for SAA link type does not have a default Server Name. The Server Name text 
box allows you to enter the Server Name which can be up to 48 characters long. Only the 
first 28 characters will be displayed on the screen, followed by an ellipse (...) to indicate 
that there are more characters that are not displayed.



Add AS/400 System Information Dialog Box

The Add AS/400 System Information dialog box is where specific data is entered for your 
AS/400 server. Click below to see specific information regarding the NetWare for SAA 
version.

NetWare for SAA

This dialog allows you to enter AS/400 system information. Your system administrator can 
provide you with this data. The System Name can be up to 10 characters with no spaces. 
Your User ID can be up to eight characters. The system you define as default will allow you 
to use APPN routing to access subsequent AS/400 linked via APPN. Finally, the link 
designator specifies the link type between your communications server and the AS/400 
host.



System Name

The system name can be up to eight alphanumeric characters (no spaces allowed) and 
typically appears in the upper right corner of the Main menu screen of an AS/400 display 
session. 
NOTE: You cannot use the characters "AS400". 
The system name must correspond the LCLLOCNAME parameter on the AS/400 command 
DSPNETA (this command provides the System Name and Location Net ID). 
If you click on the OK button and the System Name already exists on the list, a message 
box displays, informing you that the system name is already defined. Select OK to return to
the Add System Information group box or select Cancel to return to the AS/400 System 
Information dialog box.

Default System
The Default System check box can be selected for only one system and is dimmed (not 
available) if another system has already been designated as the default system. If a default
system is specified, NS/Router will attempt to connect to that system first.



User ID

The User ID (optional) is used to specify the User ID to be included in the ALLOCATE 
conversation request to AS/400s. The User ID may be different for each AS/400 that you will
access.
This entry can be up to eight characters (no spaces allowed) and is optional. If the User ID 
is not specified, the router will then use the Common User ID in the PC Information group 
box. If the Common User ID is not specified, the router will prompt you for an ID when the 
router is started.



Link

The Link drop-down list box is used to select the link to the new system.
All configured but as yet unused destination adapter addresses will be listed, along with all 
previously configured directly-connected non-dependent systems (which will be designated 
as via xxxxx where xxxxx is the name of the AS/400 system).



System Name (802.2)

The system name can be up to eight alphanumeric characters (no spaces allowed) and 
typically appears in the upper right corner of the Main menu screen of an AS/400 display 
session. 
NOTE: You cannot use the characters "AS400". 
The system name must correspond the LCLLOCNAME parameter on the AS/400 command 
DSPNETA (this command provides the System Name and Location Net ID). 
If you click on the OK button and the System Name already exists on the list, a message 
box displays, informing you that the system name is already defined. Select OK to return to
the Add System Information group box or select Cancel to return to the AS/400 System 
Information dialog box.
Default System
The Default System check box can be selected for only one system and is dimmed (not 
available) if another system has already been designated as the default system. If a default
system is specified, NS/Router will attempt to connect to that system first.

The following topic can be accessed for information on adding additional systems:
Adding Additional Systems



Add System Information (NetWare for SAA)

The Add System Information Information dialog box, shown in the following diagram, allows
you to select several options related to the NetWare for SAA physical link.

Select an area on the diagram by clicking on it with your mouse. Information about that 
topic will be displayed. (You can also select an area using Tab and Enter on the keyboard).



System Name (NetWare for SAA)

The system name can be up to eight alphanumeric characters (no spaces allowed) and 
typically appears in the upper right corner of the Main menu screen of an AS/400 display 
session. 
NOTE: You cannot use the characters "AS400". 
The system name must correspond the LCLLOCNAME parameter on the AS/400 command 
DSPNETA (this command provides the System Name and Location Net ID). 
If you click on the OK button and the System Name already exists on the list, a message 
box displays, informing you that the system name is already defined. Select OK to return to
the Add System Information group box or select Cancel to return to the AS/400 System 
Information dialog box.
Default System
The Default System check box can be selected for only one system and is dimmed (not 
available) if another system has already been designated as the default system. If a default
system is specified, NS/Router will attempt to connect to that system first.

The following topic can be accessed for information on adding additional systems:
Adding Additional Systems



Adding Additional Systems

After the first AS/400 system is configured, all other AS/400 systems can be connected 
through the same common physical link or via another connected AS/400 system. The Link 
drop-down list box will contain the specified common physical link and all connected 
AS/400 system names preceded by the word "via." An additional information column, 
entitled Link, is displayed on the AS/400 System Information screen. This column specifies 
which link was used for each system connection.

You can connect your PC to additional AS/400 systems using:

    a direct connection using the same common physical link (802.2 or QLLC). These systems
are called primary or non-dependent systems.

    via another connected AS/400 primary system (a system that your PC is connected to 
directly). This link is designated as `via...' in the Link drop-down list box. For example, you 
could connect your PC to a second AS/400 system (named SYSTEMB) via a primary AS/400 
system (named SYSTEMA).

You cannot connect your PC to additional AS/400 systems using:

    any secondary or dependent AS/400 system (a system that your PC is connected to via a 
primary system).

For example, if your PC is connected to primary SYSTEMA, you can connect your PC to 
secondary SYSTEMB via the primary SYSTEMA. However, you cannot connect your PC to 
SYSTEMC via secondary SYSTEMB.

The Link drop-down list box will display only common physical link and any `via...' links that



are available for use.
To connect a new AS/400 system via a primary AS/400 system (for example, AS/400 
SYSTEMA in the diagram on the previous page) select that system (via SYSTEMA) from the 
Link drop-down list box and click the OK button.
When a via... system link is selected, the Destination Adapter Address or X.25 CSL Target 
Name boxes are dimmed (not available).



Link

You can connect your PC to an AS/400 system through one of three common physical links: 
802.2, QLLC or SDLC. These common physical links are displayed in a Link drop-down list 
box. 

You can connect your PC to additional AS/400 systems through the same common physical 
link (802.2 or QLLC) or via another primary (non-dependent) connected AS/400 system. 

When you connect your PC to the first AS/400 system, you must choose one of these 
common physical links (default is 802.2).

    If you choose 802.2 from the Link drop-down list box, the Destination Adapter Address 
text box is displayed. You are required to enter a 12-digit hexidecimal number (the default is 
400000000001).

    If you choose the QLLC link from the Link drop-down list box, the X.25 CSL Target Name 
text box is displayed. You are required to enter a name with a maximum size of 16 
characters.

    If you choose the SDLC link, no further information is required.

Your system administrator can provide you with this information. 



Destination Adapter Address/X.25 CSL Target Name

If you chose 802.2 from the Link drop-down list box above, the Destination Adapter Address
text box is displayed. You are required to enter a 12-digit hexidecimal number (the default 
is 400000000001).

If you chose the QLLC link from the Link drop-down list box above, the X.25 CSL Target 
Name text box is displayed. You are required to enter a name with a maximum size of 16 
characters.

If you chose the SDLC link, from the Link drop-down list box above, no further information is
required.

Your system administrator can provide you with this information. 



Change AS/400 System Information

This dialog allows you to edit a particular AS/400 system entry in the list. You can edit any 
information that was originally specified with the Add System Info Dialog Box.

The Link drop-down list box (displayed for the the NetWare for SAA link only) cannot be 
used to change the common physical link (802.2, QLLC or SDLC). 

The common link cannot be changed once a router configuration has been saved. If you 
want to change the common physical link, you must delete all system information and start
again with a new common physical link. 

The Link drop-down list box can be used to change the AS/400 system configuration links 
that have already been defined for the router configuration (e.g., via SYSNAME).



Delete AS/400 System Information

When you highlight a particular AS/400 system entry in the AS/400 System Information 
group box and press the Delete.... button you will be prompted to make sure that you 
indeed want to delete the AS/400 System entry. Select Yes to delete the AS/400 system, 
select No to cancel the process.

Netware for SAA Link only: 
If you are using the NetWare for SAA Link, when you delete an AS/400 system you delete all
other logical systems connected via that system also. The system names are also removed 
form the AS/400 System Name list box.



Preferences

The Preferences dialog box allows you to select several options related to system startup.



Preferences Dialog Box

The Preferences dialog box, shown in the following diagram, allows you to select several 
options related to system startup.

Select an area on the diagram by clicking on it with your mouse. Information about that 
topic will be displayed. (You can also select an area using Tab and Enter on the keyboard).



Automatically Start All Systems

The Automatically Start All Systems check box is selected by default. The router will 
automatically initiate all of your AS/400 system links when you double click on the 
NS/Router icon providing the following steps have been performed previously:
1. The name of this configuration file (for example, myconfig.rtr) is included on the 

NS/Router command line. This is accomplished in Program Manager with the Properties 
option on the File menu. Type your router filename on the Command Line just behind the 
executable file (NSROUTER.EXE) as illustrated in the sample below:

                          c:\nsrouter\nsrouter.exe myconfig.rtr
              If you are using NetSoft's Elite/400, type:
                          c:\e400\nsrouter.exe myconfig.rtr
2. The User ID is correctly entered for each system in the Configurator window.
If you would prefer that your AS/400 systems all appear in the Inactive Links window so 
that you can drag and drop them into the Active Links window as needed, de-select the 
checkbox.



Minimized on Startup

The Minimized on Startup check box is de-selected by default. The router remains open and
you can view status messages as the router link is initialized and used. If you would like the
router to be minimized to an icon when started, select the checkbox. The router icon will 
animate upon the successful link to the AS/400.



Auto Start Router (Default Auto Start Router Configuration File)

The NS/Router Auto Start feature automatically starts the NS/Router whenever you open an
Elite/400 application or perform a function that requires the router to be operating (for 
example, any function that requires a connection to an AS/400 system).
After the router has been started, it will load the default router configuration file (.RTR) that 
you select via the Default Auto Start Router Configuration File check box. This check box 
can be selected for only one router configuration file at a time.
The path and name of the current default router configuration file (if any) is always listed 
directly below the Default Auto Start Router Configuration File check box on all router 
configuration files. If you have already designated a default file and want to change it, 
simply load another router configuration file and select the Default Auto Start Router 
Configuration File check box; the path and name will change to reflect your current 
selection.
The Default Auto Start Router Configuration File check box is dimmed (not available) when 
no router configuration file is loaded in the Router Configurator (i.e., the name on the title 
bar is Untitled).
NOTE: If a default file has not been specified, the NS/Router will be started automatically, 
but you will have to manually load a router configuration file by using the File:Open menu 
option.



NS/Router Auto Start

The NS/Router Auto Start feature automatically starts the NS/Router whenever you open an
Elite/400 application or perform a function that requires the router to be operating (for 
example, any function that requires a connection to an AS/400 system).
After the router has been started, it will load the default auto start router configuration file 
that you have selected via the Default Auto Start Router Configuration File check box in the 
Preferences dialog box. Only one router configuration file (.RTR) can be selected as the 
default auto start router configuration file.
To select a default auto start router configuration file, perform the following steps:

1. From the NS/Router Configurator main screen, use the File: Open menu option to load the
router configuration file you want to use as the default auto start file.

The router configuration file will be loaded and the name will appear in the title bar.

2. Select the Preferences button.

This will take you to the Preferences dialog box.

3. Select the Default Auto Start Router Configuration File check box.

NOTE: If another router configuration file has already been designated as the default 
file, the path and name of that file will be displayed in the text box directly below    the 
check box. When you select the check box, that path and name will change to reflect the 
path and name of configuration file that is currently loaded.

4. Save the Router Configuration file using the File:Save menu option.

The next time you perform a function that requires the router to be operating, the router 
will be started automatically and the default auto start router configuration file that you 
just specified will be loaded.

If No Default Auto Start Router Configuration File is Selected
If a default file has not been specified, the NS/Router will be started automatically, but you 
will have to manually load a router configuration file by using the File:Open menu option.



Language Selection

The Language selection drop-down list box allows you to select the language for the screen
display. 
This selection is limited to English (US) for domestic versions. 
International versions can choose between their native language (default) or English (US).



Host/PC Code Page

The default ASCII/EBCDIC mappings for each country consist of the EBCDIC code page for 
that country and the first ASCII code page listed in the table below (for example, the 
default code page for the US is 037/437 US-1). 
You can also select any alternate code page in the drop-down list, the International code 
page (500/850) or the Customize option which allows you to use your own customized code
page.
International Code Page
If you use multiple languages, you should use EBCDIC code page 500 on the AS/400 system
and ASCII code page 850 on your personal computers if possible (500/850 International). 
This is to avoid loss of certain language-specific characters.
Customize
The Customize option allows you to use your own user-defined code page mapping file. For 
more information on how to create a customized code page mapping file refer to the 
Customizing Code Pages section.

For more information on the code pages supported, see the following topic:
Code Pages Supported



Code Pages Supported

When you use the File Transfer facility to transfer files that contain character data 
(including AS/400 date, time and timestamp fields) the character data is changed byte by 
byte from EBCDIC on the AS/400 to ASCII on the PC and vice versa (except when No 
Conversion is selected).
The mapping depends on what EBCDIC code page is used on the AS/400 and what ASCII 
code page is used on the PC. The following ASCII/EBCDIC code page combinations are 
supported:

Language Country EBCDIC 
Code 
Page

ASCII 
Code 
Pages

English US United States 037 437, 850
English UK Great Britain 285 437, 850
French France 297 437, 850
German Germany/Austria 273 437, 850
International International 500 850
Italian Italy 280 437, 850
Norwegian Norway 277 850, 865
Spanish Spain 284 850, 437
Swedish Sweden 278 437, 850

All code pages are documented in the AS/400 National Language Support Planning Guide 
(IBM Publication No. GC41-9877).



Customizing the Code Page Mapping File

You can create a customized code page mapping file (.MAP). This    allows you to translate 
any character to any other character.
To create customized code page mapping file perform the following steps:

1.    From the NS/Router Configurator main screen, select the Preferences button. The 
Preferences dialog box will be displayed. 

2.    Select the Customize option from the Host/PC Code Page list box.
3.    Select OK.
4.    The default code page mapping file name of CUSTOM.MAP will be placed in the 

[Workstation] section header in your router configuration file (.RTR) as illustrated below:

                        [Workstation]
                        TranslateTable=CUSTOM.MAP

5.    To customize the CUSTOM.MAP file, either copy an existing code page mapping file into 
the CUSTOM.MAP file and edit it to suit your needs or create your own mapping file 
within the CUSTOM.MAP file.

NOTE: All available code page mapping files are located in the NS/Router directory. The 
format for these file names is:    ExxxAyyy.MAP, where: xxx is the three-digit EBCDIC code
page number and yyy is the three-digit ASCII code page number. (For example, the US-1 
code page mapping file is named E037A437).

If you choose to create your own file, you must keep the required translation table format
of 32 lines of 32 characters (composed of 16 two-digit hex values), no spaces and each 
line ending with a carriage/linefeed. For more detailed information on the format of the 
translation table, refer to Translation Table Format.

6.    Save the modified CUSTOM.MAP code page mapping file file.
If the File Transfer facility is currently running, you must end the emulation and restart it for
your modifications to take effect.



Translation Table Format

The format of the code page mapping files is 32 lines of 32 characters (1024 characters). 
Each line consists of 16 hexadecimal values (2-digit values, no delimiters) and a carriage 
return/line feed combination.
The first 16 rows convert ASCII characters to their EBCDIC equivalent (and vice versa). The 
next 16 rows convert EBCDIC characters to their ASCII equivalent (and vice versa).
The numeric value of a character is used as the index into the translation table. The type of
conversion determines which portion of the table is used as the starting index point (ASCII 
to EBCDIC starts on line 1; EBCDIC to ASCII starts on line 17). The index position in the 
table specifies the hexadecimal value that the character is to be converted to. For example,
if you are using the table to convert an uppercase A, the hex value of 0x41 (65 ASCII) is the
index. Position 0x41 in the table (line 5, value 2) is 'C1'. All uppercase A characters are 
converted to EBCDIC values of 'C1'.
For information on how to create and implement your own customized code page mapping 
file, see Customizing Code Pages.



File Open Dialog Box

The following options allow you to specify a router configuration file (*.RTR) to use for 
AS/400 connectivity. You can define multiple router configuration files that use different link
types or AS/400 hosts. These files can be then be opened by the Router application and 
used to actually link to your AS/400.

File Name
Type or select the name and location of the file you want to open.    In most cases a default 
filename displays in this field. The box lists files with the extension you select    in the List 
Files of Type box.

List Files of Type
Select the type of file you want to open.
NS/Router Configurator uses the following default file types:

 .RTR for router configuration files
 .PCS for PC Support files

Drives
Select the drive containing the file that you want to open. 

Directories
Select the directory containing the file that you want to open.

Read Only check box
Select the Read Only check box if you want to save the file as read only.



File Save As Dialog Box

The following options allow you to specify the name and location of the router configuration
file you are about to save. You can specify a name for a new file or you specify a new name 
for an existing configuration file. This can be useful for making slight changes in 
configuration details for different links or AS/400 hosts. 

NOTE:  You must specify a Location Name and at least one AS/400 system before you can 
save a router configuration file.

File Name
Type a new filename to save the file with a different filename. 
A filename can contain up to eight alphanumeric characters (A-Z and 0-9) and an 
extension of up to three characters. Special characters are not permitted. File names are 
not case-sensitive.

Save File as Type
Select the type of file you want to save.
NS/Router Configurator uses the following default file type:

 .RTR for router configuration files

Drives
Select the drive in which you want to store the file.

Directories
Select the directory in which you want to store the file.

Read Only check box
Select the Read Only check box if you want to save the file as read only.



Saving Your Router Configuration File

If you have just configured a new NS/Router Configuration file, use the File: Save As... menu
option. If you have made changes to an existing NS/Router Configuration file, use the File: 
Save... menu option.    
A dialog box is displayed which allows you to save the configuration file as any eight 
character name that you wish by replacing the asterisk (*) in the default file name (*.RTR) 
with the desired name (for example, MYCONFIG.RTR). The file is saved in the Windows 
directory (\WIN) by default.

Where to go Next
Starting the NS/Router



Starting the NS/Router

Once you have created and saved your router configuration file, there are three ways to 
start the NS/Router:
Auto Start Method
Command Line Option Method
Manual Method



Manually Starting the NS/Router

To manually start the NS/Router, double-click on the NS/Router icon.
You must then load a router configuration file (.RTR) using the File:Open menu option.

NOTE:  If you are running 802.2 (in Standard mode) or Twinax (in 386 Enhanced mode) you
need to verify that you have loaded the correct TSR program before you run Windows.



Automatically Loading a Router Configuration File

You can set the NS/Router up so that it automatically loads the Router configuration file of 
your choice whenever you double-click on the NS/Router icon by performing the following 
steps:

1.    Click once on the NS/Router icon.
2.    Click on the Program Manager File: Properties menu option.
3.    Type your router configuration filename (myconfig.rtr is used in the example below) on 

the Command Line just behind the executable file (NSROUTER.EXE) as illustrated in the 
sample below:

            d:\path\nsrouter.exe myconfig.rtr

where d:\path is the location of the NS/Router program files and myconfig.rtr is the name
of the router configuration file you want to load. 
If your router configuration file is in a drive and directory other than the default (C:\WIN) 
you must also include the location of the router configuration file (for example, c:\
nsrouter\nsrouter.exe c\rtr_files\myconfig.rtr).

4.    Click on OK to return to the NS/Router Program Group.
5.    Double-click on the NS/Router icon and your router configuration file loads 

automatically and the NS/Router Window is displayed.

NOTE: Another way to automatically load a router configuration file is to use the Window's 
File Manager File: Associate... menu option to associate the Router configuration file of your
choice with the ROUTER.EXE file. For detailed information on the Assoicate... option, consult
your Word for Windows User's Guide.

NOTE:    If you are using NetSoft's Elite/400, you must verify that the NS/Router is specified 
as the Router Type (default) before starting the router. This is done by choosing Session 
Manager from the Elite/400 main window and then the Set Global Options... dialog box. For 
detailed information refer to the Elite/400 online help.



Creating a Router Configuration File

To create a Router Configuration File you must:
Select a PC to AS/400 Physical Link Type
Specify the Link Profile
Provide Information About Your PC
Add AS/400 System Connections
Set Start Up Preferences.
Save your NS/Router configuration file



Adding Keywords to the NS/Router Configuration File

The NS/Router file that you created when you configured the NS/Router (default filename 
*.RTR, for example MYCONFIG.RTR) contains the default settings that will be used by the 
router.
Additional settings, called keywords, can be manually added to the Router file (see the 
Modifying the Router File section below). These keywords have been provided to address 
unique or special requirements or to allow for customization of specific classes of systems. 
Keywords use the format: keyword=setting.
The keywords that are currently available are listed below:

    CheckSystem=0 or 1
(This keyword applies to the NetWare for SAA link only. This keyword allows you to specify 
that a session is to be used in order to allow the router to detect when an AS/400 system 
connection goes down and attempt to restore the connection.)
    ConnectFail=d:\path\filename

(This keyword specifies that an automatic dump should be taken whenever the 
ConnectPhysical verb fails.)
    PeekMessage=0 or 1

(This keyword allows you to set PeekMessage to 0 (do not yield) or 1 (yield.)

Keywords are case-sensitive, contain no spaces, and must be entered exactly as shown.

Enable Checking of AS/400 Connections
This keyword applies to the NetWare for SAA link only.
The default setting, CheckSystem=0, does not tie up a session in order for the router to be 
able to detect when an AS/400 system connection goes down and attempt to restore the 
connection.
If you want the router to detect when any AS/400 system connection goes down and 
attempt to restore the connection and you are willing to loose a session in order to do this, 
locate the [E400RTR] section header of the router file and modify the following keyword:
                    CheckSystem=1
Save the modified Router file (.RTR).

Adding an Automatic Dump Option
To request the NS/Router to automatically dump its link state information whenever the 
ConnectPhysical verb fails, locate the [NSROUTER] section header of the router file and add
the following keyword on a line by itself below the section header:
                  ConnectFail=d:\path\filename
Where d is the drive and path\filename are the directory path and filename where you 
would like the dump file to be written.
Save the modified Router file (.RTR).

Adding a Peek Message Designation
The NS/Router, by default, issues a Peek Message to yield control (PeekMessage=1), 



allowing background applications to run during APPC verb execution. This offers certain 
performance enhancing benefits, but may not be compatible with applications that expect 
Windows to be halted until a return code is received. If you do not want the NS/Router to 
issue Peek Messages, locate the [NSROUTER] section header of the router file and modify 
the following keyword:

PeekMessage=0
Save the modified Router (.RTR) file.

Modifying the Router File
Keywords are added by editing the existing router file which was created by saving your 
router configuration (for example MYCONFIG.RTR) as detailed in Saving Your Router 
Configuration File
You may use any text editor to modify the router file, or any word processor that can edit 
ASCII or ANSI text.
NOTE:    If you use a word processor to edit the router file, you must save it as an ASCII or 
ANSI text file. If you save the configuration file in the word processor's file format, the 
Router cannot read it and aborts with an error.



Specifying a link type

The first step in creating your NS/router configuration file is to select the link type, or how 
your PC is connected to the host system.    The supported link type in this NetWare for SAA 
version is:

 LAN connection via Novell NetWare for SAA

To select a link type, use the scroll bar next to the Link Type drop-down list box on the 
NS/Router Configurator main screen, as shown in the following diagram:

As you move the scroll bar, you'll see the various link types available. Select the link type 
you want to use by clicking on it with your mouse.
You are now ready to specify the link's profile, or the specific configuration required for your
connection using the link type.    For details see Specifying the link profile.



Specifying the link profile

Before you can specify the link profile, you must have selected the proper link type for your
connection to the host.    For details see Specifying the link type.

To specify the link profile, choose the Change... button in the Link Information group box, as
shown in the following diagram.

Choosing this button causes the Change Link Information dialog box for your link type to 
display.    The information specified in the dialog box customizes NS/Router for your 
connection requirements.



OK Button

Choose this button to accept the values that are displayed and return to the previous 
screen.
Remember that changes are not permanent until you save the router configuration file.



Cancel Button

Choose this button to ignore any changes that you have made and return to the previous 
screen.



Help Button

Choose this button to receive help information pertaining to the current screen.



Advanced Button

Choose this button to display more advanced link profile settings.



Add Button

Choose this button to add a gateway to the Gateway Name(s) group box.

The Add Gateway Name dialog box is displayed.



Change Button

The Change button is dimmed (unavailable) until there is at least one gateway in the 
Gateway Name(s) group box.

After selecting a Gateway Name from the list, choose this button to make changes to the 
system information.

The Change Gateway Name dialog box is displayed.



Editing a Router File

To edit an existing Router Configuration file perform the following steps:

1. Use the File:Open menu option to open the file you want to edit.
2. Change PC to AS/400 Link Information.
3. Change PC Information.
4. Change AS/400 System Information.
5. Change Start Up Preferences.
6. Use the File:Save menu option to save the edited file.



Password

Type in a password, which can be up to 10 alphanumeric characters (spaces and special 
characters are not allowed).
The password that you enter here is associated with this User ID and this System Name 
only. When this system is started by the router, you will not have to enter your User ID or 
password.
The password is only in effect if a User ID has been entered.



Password Verification

Type in the password exactly as you entered it in the Password text box above. The 
Verification entry is compared to the Password entry in order to verify the password is the 
same.
If the password that you type here does not match the Password entry, when you choose 
OK the following message is displayed: "Password entry does not match with Verification 
entry." Choose OK and enter the Password Verification again until it matches the Password 
entry.




